PART 1: LINUX REVIEW

1. Start a terminal program

Now start a terminal program (xterm, rxvt, gterm, kterm, etc), (if using cygwin, double click the cygwin icon) at the command line type "man g++" and enter. "man" is the command for displaying the manual of any command in linux that has one. Notice the options '-o' and '-c'. Press the letter "q" to exit the man pages. Note that the commands are case sensitive.  Note: not all man pages for cygwin are installed by default.
2. Start Xemacs

At the command line, type "xemacs & ". Xemacs should start in a separate window. To open a file click the "Open" button at the top left corner of the xemacs window. In the popup window, type "HelloWorld.cpp" and hit enter. A blank buffer should appear. Type the following code...

//------------------------------------------------------------

// Purpose:  Test g++ compiler under Linux.

// Author:   We Love OS

// Date:     8/27/2007

//------------------------------------------------------------

#include <iostream>

using namespace std;

int main( int argc, char * argv[] )

{

   cout << "Hello World" << endl;

}

Save the file using the Save button at the top of the window or press the keys "Ctrl-x Ctrl-s"

3. Compile and Debug

The compiler/linker we will be using is accessed via the command g++ or gcc. g++ is the c++ compiler, and gcc is the c compiler.  For example, to compile the program written above do the following:

· Open a terminal window.

· Change directories to be in the same directory as HelloWorld.cpp

· Type the following: 

g++ HelloWorld.cpp -o HelloWorld 

This example illustrates one way to compile and create an executable program from a source file:

g++ source_file_name -o executable_file_name 

What actually happens is that the compiler is invoked to translate the source code into machine code, then the linker is invoked to combine the machine code with certain standard system libraries to create the executable program.

Sometimes -- especially when multiple source code files are involved -- we will use the compiler to separately create these machine code files (technically called relocateable object code files). The files will be linked together later with other object files and libraries to create the final executable program.

Let's illustrate this with an example. Suppose I create a class called Frap. It is a common convention to create our class using two source files: a header file named Frap.h and an implementation file named Frap.c++. The header file contains the class definition, including its methods and instance varaibles. The implementation file holds the C++ code implementing the various methods. Since classes are normally designed to be reusable in many different contexts, we generally want to compile the Frap class and save its object code to be linked later with its various clients. To compile the Frap class into a relocateable object code file, we specify the -c flag to the compiler: 

g++ -c Frap.c++ 

Notice there is no "-o executable_file_name" in the above command. Instead, the compiler will create a file called Frap.o. Now suppose that HelloWorld.cpp requires the services of a Frap object. We would add an include directive for Frap.h to HelloWorld.cpp, create an object and use it. Then we could build the corresponding executable program in any of several ways. The most common approach is to continue the separate compilation, followed by a final program linking operation. Specifically:



g++ -c HelloWorld.cpp



g++ HelloWorld.o Frap.o -o HelloWorld

As a side note to xemacs users: all of the above commands can be executed directly from xemacs from the Tools menu.

     Tools -> Compile

At the bottom of the xemacs window is a command line now. It should have something like "make -k" in the command line. Backspace over the text and replace it with

     g++ HelloWorld.cpp -o HelloWorld

and press enter. A second window will open. If there are no errors, the following text will be seen

     Compilation finished at ... 

in which case you are finished with this step. If not, press the keys "Ctrl-x `". (The tick mark is the back tick, same key as the tilda ~) This will take you to the location ofthe first error. Fix the error and continue until there are no more errors, then compile again.

4. Execute "HelloWorld"

If there are still two windows open in your xemacs buffer, you may close one by using the command "Ctrl-x 1" with the cursor inside the window that you want to keep.

You may run the program in two ways. 1 - By typing the command "./HelloWorld" into the xterm that you used to run xemacs and press enter, or 2 - open a shell inside xemacs and run the program the same way. To open a shell in xemacs, press the keys "Alt-x". At the command line should appear "M-x". Type "shell" and press enter. Now in the shell window, type "./HelloWorld" and press enter. Hopefully your program will run properly.

5. Close XEmacs and Exit

You may exit XEmacs using the menu "File -> Exit XEmacs". 

6. Common Linux Commands

A number of useful Linux commands are listed and explained below. To find out more about any Linux command, use the online manual pages provided by the system. These pages typically show the different options available, examples and list any known bugs. 
Usage: man command_name.

Listing the contents of your current directory: ls 
ls: list the files and subdirectories in the present directory without details of each file 
ls -l: list the files and subdirectories in the present directory with details of each file 
ls -a: display all the files in a directory including files starting with '.'

display the contents of a file: cat 
cat filename: display the contents of a file without pausing between screens

display a file a screen full at a time: more 
more filename

deleting a file: rm 
rm filename

deleting a non_empty directory recursively: 
rm -r directory_name 
Note: Be careful with this command. You can delete a LOT of files at one time. Use rm -ir to prompt before each delete.

display the current working directory: pwd 
pwd 

creating a new directory: mkdir 
mkdir new_directory_name

deleting an empty directory: rmdir 
rmdir empty_directory_name

copying one file/directory to another file/directory: cp 
cp source_file destination_file 
cp source_file destination_directory 
cp source_file1 source_file2 destination_directory 
Note: paths can be specified in file/directory names.

Renaming/Moving a file/directory: mv 
mv source_file destination_file/directory 
mv source_directory destination_directory 
Note: paths can be specified in file/directory names

changing to a directory: cd 
To move to a directory in the current directory: cd directory_name 
Moving to an upper level directory in the tree: cd .. 
To get back to your home directory: cd 
Note: often paths will be useful as arguments. Ex: cd dir1/subdir1. This command moves you to a subdirectory subdir1 in dir1.

changing user permissions of files/directories: chmod 
To protect contents of file/directory: chmod 600 filename/directory 
Note: see the linux manual pages for help on chmod.

clearing the screen: clear 
clear

exit from the shell: exit/logout 
exit 
logout 
Please note that wild cards (characters * and ?) can be used wherever appropriate with the commands.

7. Other Resources

There are many resources on the web for learning linux and XEmacs commands. Here are three links you may find helpful:


http://en.tldp.org/ 
http://www.ctssn.com/ 
http://www.cse.ohio-state.edu/~weide/sce/reference/xemacs/index.html 

PART 2: Makefiles

As projects get larger and larger, it becomes important to manage the build process. A tool called make helps do this. Make looks inside of the current working directory for a file called "Makefile" For example, we could type in

g++ Driver.cpp Playlist.cpp Song.cpp -o lab1

to successfully build a program involving the three source files Driver.cpp Playlist.cpp and Song.cpp, but doing so recompiles all of the objects every time. With make we can modularize the build process, and make will automatically only recompile the files that have changed since the last compilation. The proper syntax for a Makefile consists of variable assignments, comments, and rules. Rules consist of target, dependencies, and commands. Let's look at an example Makefile for our HelloWorld/Frap example from the compiler discussion. 

#A sample Makefile 

#The pound sign marks the rest of the line as comments

#the format for a rule is...

#target: dependecies

#<TAB>command

# Note: The command must begin after a <TAB>. Using a number

# of spaces in place of the tab will not work

all: HelloWorld.o Frap.o

        g++ HelloWorld.o Frap.o -o HelloWorld

HelloWorld.o: HelloWorld.cpp Frap.h

        g++ -c HelloWorld.cpp

Frap.o: Frap.cpp Frap.h

        g++ -c Frap.cpp

We can make it easier to manage common compilation flags among several source code files and other aspects of the build process by introducing variables for the compiler, other compiler flags, the object file names, etc. One important compiler flag that we will need for debugging is the -g option, which specifies to the compiler that the object file should be created in a way that preserves enough information to be compatible with a debugger. 

#Using variables in our Makefile

#variables

CC=g++

CFLAGS=-g –c

SRC=Frap.cpp HelloWorld.cpp

OBJS=$(SRC:%.cpp=%.o)   # Create the OBJS variable from the SRC

                        # variable by replacing all .cpp with .o

#targets

all: $(OBJS)

        $(CC) $(OBJS) -o HelloWorld

HelloWorld.o: HelloWorld.cpp Frap.h

        $(CC) $(CFLAGS) HelloWorld.cpp

Frap.o: Frap.cpp Frap.h

        $(CC) $(CFLAGS) Frap.cpp

Finally, there is one more addition to the Makefile that is helpful: the "clean" target. The clean target allows you to quickly clean up the current directory by deleting object files and backup files that are not needed for homework submission. 

#Using variables in our Makefile

#variables

CC=g++

CFLAGS=-g -c

OBJS=Frap.o HelloWorld.o

#targets

all: $(OBJS)

        $(CC) $(OBJS) -o HelloWorld

HelloWorld.o: HelloWorld.cpp Frap.h

        $(CC) $(CFLAGS) HelloWorld.cpp

Frap.o: Frap.cpp Frap.h

        $(CC) $(CFLAGS) Frap.cpp

#helpful for deleting object files and back up files

#from the current directory for homework submission

clean:

        rm -f $(OBJS) HelloWorld *~

You can use this Makefile from the command line by typing the command make and specifying an "optional target". If you do not specify the "optional target", the first target is attempted, in this example the target "all". Remember, only the targets which have dependencies that have been modified since the last make command will have the command executed. Some examples of using the make command from the command line prompt follow. 

make Frap.o

make HelloWorld.o

make all

make clean

make

Practical suggestions for writing your own make files 

· The default name for a Makefile is “Makefile” or “makefile”.  The program looks for these two files to execute.  If you wish to name your Makefile something other than the default, you must use the –f option and give the name of the file to use. For example.

· make –f MyMakefile

· make –f MyMakefile clean

· The first command executes the first target in the file. The second version executes the “clean” target in the makefile

· Create one target that links together all the compiled object files in your program. Its label could be 'all' and its dependency list includes an object file for every .cpp file in your project. The command should link together all the object files and specify an executable file name. For example... 

· all: HW1.o Class1.o Class2.o

·         g++ -g HW1.o Class1.o Class2.o -o hw1

· Create one target for each .cpp file in your project. 

· The label should be the name of the .cpp file with a .o extension instead of .cpp.

· The dependency list should include the .cpp file and every user defined header file that is included in the .cpp file.

· The command should compile the .cpp file into object form and use the -g option to enable the debugger, e.g. 

· g++ -g -c Example.cpp

(But remember to use a CFLAGS mechanism as illustrated above for "-g -c".)

· Create a clean target that removes all the unneeded files for submission, including the executable file, all object files, and any backup files. For example... 

· clean:

·         rm -f hw1 *.o *~

You will be using make files all semester, and you are required to submit them with your projects.

